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Acquire the Scanner 
TWAIN Driver 
The TWAIN driver is the scanning module provided 
with your scanner. It is easily accessed from within 
the bundled scanner software or from within any 
TWAIN-compliant program. Before you start with 
the steps below, be sure you have installed and    con-
fi gured the bundled scanner software. 

1. Launch Windows.
2. Run the host TWAIN-compliant software (e.g. 

Photoshop)
3. Call up the TWAIN Data Source by selecting         
     Acquire from the File menu. (In some programs, 
    the Acquire command will appear in a submenu    
  under the Import command.) The TWAIN       
   dialog box will appear in a submenu under the  
    Import command.

The TWAIN dialog box contains control settings, 
which you must set prior to scanning a document. 
The basic steps to scan a document are:
1. Prescan the document.
2. Set the desired image area to be scanned.
3. Select the scan source.
4. Select the desired scan mode.
5. Select the desired resolution.
6. Click on the Scan button.
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Folders
Contain different 
control settings

The Dialog Box
The TWAIN dialog box is divided into two sections: the left section where most of the control settings are 
located, and the right section, which is the Preview Window.

Preview Window
Used for viewing the 
prescan image.
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Resolution
Sets the resolution in dots per inch 
(dpi). 

Output Scaling
Changes the dimensions of the     
fi nal output.

Scan Source
Sets the media type of the 
document to be scanned.

Scan Mode
Determines how the scanner 
will read the image and refers 
to how the image will be      re-
produced after it is scanned.

Photo Refresh
Photo Refresh allows you to  au-
tomatically lighten and sharpen 
the scanned image by clicking on 
its icon. This function is applicable 
when you are scanning images in 
Color 24bit.

Descreen
Sets the media type of the document 
to be scanned to reduce image noise.

Image Size
Displays the amount of computer 
space needed to display or save the 
selected image area.

Scan Size
Refers to the size of the im-
age or document that you are 
about to scan.

JPEG2000 Scan
The latest image compression 
standard that usually provides 
smaller fi le size and higher    im-
age quality than the original 
JPEG.
Width and Length
Show the dimensions of the   im-
age area inside the Crop Frame.

Color Matching Control
Color Matching allows the scanner 
to more accurately refl ect the actual 
colors of the original image. 

The Main Folder
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Thumbnails
Are used to see the effects 
of any changes in the control 
settings.

The Enhancement Folder

Brightness Control
Allows you to adjust the overall 
amount of light in the image 
through a range of values (–127 
~0~+127).

Channel Selector Control
Allows you to select the   chan-
nel layers (red, green and 
blue) that make up a color 
image. You can choose to 
change the channels indi-
vidually or choose master to 
change all channels equally 
and simultaneously. 

Contrast Control
The Contrast Control allows you 
to adjust the overall amount of 
black areas or white areas in the 
image through a range of values 
(–127~0~+127). 

Brightness/Contrast Control

Preview Button 
This button allows you to see the 
effect of any changes made to 
the image. 
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Level Control
Use the level slider to adjust an 
image’s contrast and brightness. 

Histogram
Shows the distribution of the 
brightness levels in the image.

Eyedropper tools 
Eyedroppers are used to iden-
tify an image’s highlights and 
shadows. 

Thumbnails
Are used to see the effects 
of any changes in the control 
settings.

The Enhancement Folder 

Channel Selector Control
Allows you to select the chan-
nel layers (red, green and 
blue) that make up a color 
image. You can choose to 
change the channels indi-
vidually or choose master to 
change all channels equally 
and simultaneously. 

Level Control

Preview Button 
This button allows you to see the 
effect of any changes made to 
the image.
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Curve Control 
Applying a curve to an image 
enhances favored brightness 
ranges at the cost of others. 

Add Anchor 
To make a curve, simply place 
an   anchor on the diagonal line 
and adjust its position. Add more 
anchors if you have to make a 
more complex curve. 

Remove Anchor 
You can also remove anchors. 

Thumbnails
Are used to see the effects 
of any changes in the control   
settings.

The Enhancement Folder 

Channel Selector Control
Allows you to select the channel 
layers (red, green and blue) that 
make up a color image. You can 
choose to change the channels 
individually or choose master to 
change all channels equally and 
simultaneously. 

Curve Control

Preview Button 
This button allows you to see 
the effect of any changes made 
to the image.
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Thumbnails
Are used to see the effects 
of any changes in the control 
settings.

The Enhancement Folder

Hue/Saturation Control

Preview Button 
This button allows you to see 
the effect of any changes 
made to the image. 

Saturation Slider 
Lets you adjust an image’s color 
purity. 

Hue Slider 
is composed of two color bars. 
The upper one is static and the 
lower one movable. Slide the  
latter, and you will see the image 
shift its overall coloring. 
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The Filters Folder

None
No fi lter is applied.

Invert
Reverses an image to its 
negative or compliment.

Flip
Creates a mirror image of 
the original.

Blur
Smooths or softens the   im-
age.

Emboss
Makes the elements in the 
image appear raised or 
sunken.

Sharpen 
Enhances the detail in the     
image.

Thumbnails
Are used to see the effects 
of the selected fi lter.

Unsharp Mask
Emphasizes shape edges 
and color boundaries.

Filter Control Buttons 
Use these buttons to add 
/subtract a degree of the 
Blur or Sharpen fi lter. 

The Filters Tab allows you to   
adjust the individual effects of 
the scanned image by applying       
various fi lters to the image, prior 
to scanning. 
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Batch Scan Button
Allows creation of up to 30 scan 
regions (or Crop Frames) for  mul-
tiple scanning.

Crop Frame
Outlines the scan area or region 
that will be included in the fi nal 
scan.

The Preview Window

Preview Button
Allows you to see the effect of any 
changes made to the image.

Zoom Tool Button
Allows you to enlarge/shrink an 
area of the image in the preview 
window 

Cropping Tool 
Selects the area in the Preview 
Window that will be used as the 
fi nal scan. Language Setting 

Allows you to select the desired 
language that the dialog box will 
be displayed in. 
Help Button
Provides On-line Help.
Exit Button
Click to exit (or close) the TWAIN 
or Batch Scan Dialog boxes.

Scan Button
processes the pre-scanned      im-
age, and displays it in the host 
software (where you opened up 
the TWAIN dialog box). 
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Previous Button
Returns the most recent selection to its 
previous setting. (Reloads the last saved 
image settings.)

Reset Button
Returns settings to their default values.

Load Button
Loads previously saved image settings.

Save Button
Saves the current image settings.

Info Button
Lists information about the current settings 
being used. 

Prescan the Image
A Preview is a quick low-      
resolution scan of the entire 
original image. From this low-
resolution scan you can get a 
clearer idea of the image area you want to include 
when you click Scan. To Preview, the steps are:

1.Place the document face down on the scan       
    window glass.
2. Click the Preview button in the dialog box. After 
     the scanner has scanned the document, the scanned
   image will appear in the Preview Window. From 
  the Preview image, you can now set the exact  
    image area you wish to include in your fi nal scan.
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2. Select the scan source. 
Since we are going to scan a color photograph, 
choose Refl ective.
Refl ective: 
when scanning paper-based documents such as   
photographs or text (magazines, books, or images).
3. Select the desired scan mode. 
The Scan Mode determines how the scanner will 
read the image.
• 48-Bit Color captures images in 281 trillion colors
• 24-Bit Color captures images in 16.7 million colors
• Gray (16 bit) captures 16 bits of grayscale image 

information for every pixel in the screen image
• Gray (8bit) captures 8 bits of grayscale image 

information for every pixel in the screen image. 
Reproduce up to 256 shades of gray. 

• Lineart is used for text documents or black-
  and-white images

Set Up the Scan Parameters
1. Set the desired image area to be scanned. 

Use the Crop Frame in the Preview Window to     
outline the image area you wish to scan. Click one 
of the sides or corners of the Crop Frame and drag it 
out or in to the desired length 
and width. 
To move the entire Crop 
Frame, position the mouse 
cursor inside it and drag with 
the left mouse button.

Only the area inside the Crop 
Frame will be included in the resulting scanned im-
age when you click Scan. The size information at the 
bottom of the dialog box is automatically updated 
when the Crop Frame is resized.

Crop frame
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4. Select the desired resolution. 
Resolution is a measure of how much image detail in-
formation the scanner is to capture in a scan. A higher 
resolution results to a sharper image but    requires 
more disk space for fi le saving. For this  session, set 
the resolution to 300 dpi.

Execute the Scan Command
When you are finished with 
the control settings, click on 
the Scan button. The scanner     
begins to scan the document 
and a message box appears on the screen displaying 
the progress of the scan.

When the scan is fi nished, the image will be displayed 
in the main screen of the host software.

Using Batch Scan 
Batch scanning is an easy way to multi-scan any part 
of your document using different scan modes and 
resolutions. In batch scanning, you can specify up 
to a maximum of 30 scan regions, or you can scan a 
single region several times using different combina-
tions of scan modes and resolutions.

To activate batch scanning, click on the 
Batch Scan button. This will bring up the 
Batch Scan dialog box.
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The Batch Scan Dialog Box
The Batch Scan dialog box contains several controls 
that make batch scanning simple and easy to use. It will 
also display the number of batch jobs that you make 
when you create the scan regions.

• New Batch Button
  Click on this button to create a new 
  scan region on the image in the       
   Preview Window.

• Duplicate Batch Button 
 Click on this button to duplicate a 
 batch job. You can then specify        
 different control settings for this 
  particular batch job.

•  Trash Batch Button
 Click on this button to delete the      
  selected or highlighted batch job.

• Cancel Batch Button
  Click on this button to cancel batch 
  scan and exit the Batch Scan dialog 
  box.
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To perform a batch scan, the steps are:

1. Click the Batch Scan button. The Batch Scan   
    dialog box appears.
2. Create a scan region:

(a) Move the cursor inside the Preview Window.
(b) Hold down the Shift key, press the left mouse
 button and drag the mouse to create a crop frame.
(c)Reposition or resize the crop frame if            
      necessary.

3. Set the desired scan mode and resolution for the 
    current scan region.
4. Repeat steps 2 and 3 if you wish to create additional 

scan regions.
Note: Using the Batch Scan arrows allows you to 
view the different batch jobs.

5. Click Scan. The scanner will begin to scan the 
batch jobs one after the other.

The Batch Box contains the thumb-
nail image, DPI, scan mode and 
image size of each batch scan. The 
batch number (e.g. 1/3, number one
out of three) is always displayed at 
the top of the batch box along with 
the Batch Scan Status.



For 32-bit Windows user with Photoshop CS5
Download the Photoshop CS5 Optional plug-ins from:
http://www.adobe.com/support/downloads/detail.jsp?ftpID=4688

Installation Instructions:
Unzip the downloaded fi le, and copy "Twain_32.8BA" fi le to the //Adobe Photoshop 
CS5/Plug-ins/Import-Export folder. Restart Photoshop to enable the plug-in.

For a 64-bit Windows user with Photoshop CS5
Photoshop does not install TWAIN on any 64-bit editions of Windows. The 
downloadable TWAIN plug-in is 32-bit only. 

Alternatively, you may:
• Open Photoshop CS5 in 32-bit mode to enable TWAIN scanning functionality with 

32-bit drivers. 
 OR
• Use the Windows Image Acquisition (WIA) interface to import from your scanner.

Using TWAIN in Photoshop CS5 (PC)
Windows OS directory

Hints: 
To check whether your system is 32-bit or 64-bit, do the following:

Windows Vista/Windows 7
Click Start, then right-click Computer. From the pull-down menu, click Properties. You will 
see the System Type listed. 

Windows XP
Click Start, then right-click My Computer. From the pull-down menu, click Properties. If 
you see "x64 Edition" listed, then you're running the 64-bit version of Windows XP. If not, 
you are running the 32-bit version instead. 



For a MAC OS X user with Photoshop CS5
Download the Photoshop CS5 Optional Plug-ins from:
http://www.adobe.com/support/downloads/detail.jsp?ftpID=4904

Installation Instructions:
1. Double-click TWAIN.dmg 
2. Copy the TWAIN.plugin to Applications\Adobe Photoshop CS5\Plug-ins\Import-Export
3. Restart Photoshop in 32-bit mode to enable the plug-in.

For a MAC OS X user with Photoshop CS4
Download the Photoshop CS4 Optional plug-ins from:
http://www.adobe.com/support/downloads/detail.jsp?ftpID=4047
*This download includes plug-ins for Photoshop CS4 English, Spanish and French 
versions. 

Installation Instructions:
1. Quit Photoshop CS4.
2. Copy the TWAIN plug-in from the \<language>\Goodies\Optional plug-ins\Import-Export 

folder to: Applications\Adobe Photoshop CS4\Plug-ins\Import-Export
3. Restart Photoshop to enable the plug-in.

MAC OS directory

TWAIN Plug-in enabled

The scanner model 
name will display here.

Using TWAIN in Photoshop CS5 / CS4 (Mac)
Hints: 
To run Photoshop CS5 in 32-bit mode:
1. Quit Photoshop CS5.
2. Navigate to Applications/Adobe Photoshop CS5 folder.
3. Select the Adobe Photoshop CS5 application fi le.
4. Choose File > Get Info.
5. Select "Open in 32-Bit Mode".
6. Close the Get Info dialog box.
7. Restart Photoshop CS5.



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


